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This Publication, including all photographs, illustrations and software is protected under international
copyright laws, with all rights reserved . Neither this manual, nor any of the material contained herein,
may be reproduced without the express written consent of Diamond Engineering. The information in
this document is subject to change without notice. Diamond Engineering makes no representations or
warranties of merchantability or fitness for any particular purpose. Further Diamond Engineering
reserves the right to revise this publication and to make changes from time to time in the content
hereof without obligation of Diamond Engineering to notify any person of such version changes.
Trademarks

IBM, VGA and ps/2 are registered trademarks of International Business Machines.
AMD is a registered trademark of Advanced Micro Devices Inc.
Intel, Pentium III/4 Are registered trademarks of Intel Corporation
Microsoft,Office, Excel and Windows NT/95/98/ME/2000/XP are registered trademarks of Microsoft
Corporation.
VEE, VEE Runtime, and Agilent are registered trademarks of Agilent Corporation.
HP, HPIB, are registered trademarks of the Hewlett Packard Company.
Anritsu, Scorpion, Lightning are registered trademarks of the Anritsu Corporation.
Labview is a registered trademark of the National Instruments Corporation
MatLAB is a registered trademark of Mathworks.

NOTICE
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Introduction

Congratulations on your purchase of a Diamond Engineering
Desktop Antenna Measurement System! Also Known As DAMS

Diamond Engineering’s Desktop Antenna Measurement System has been designed to aid in
the testing and development of small to medium sized  Antennas. Using state of the art software this
system enables you to make many different types of measurements with complete user-definable
configuration settings. The advanced Processing Feature enables you to not only plot 3D graphs of
the measurements, but save and recall those measurements for future use or comparison. Using the
Group Delay function will enable you to calculate the exact distance of the Test Antenna, Identify
Multipath rays, and eliminate the need to use another measuring device. Our software also allows you
to export your data to a 3rd party application or spreadsheet.

This manual will fully assist you step by step with Assembling, configuring, and using the
Desktop Antenna System. To achieve the full functionality of the rotator system we expect you to have
some prior knowledge about the concepts and theories about Microwaves and Antenna Design and
Development before using this software and rotator unit.

We cannot emphasize enough about the importance of fully reading and understanding this
manual before using this piece of equipment to avoid any risk of damaging the unit and possibly

voiding your warranty.

Best Regards,  The Diamond Engineering Team



7

Key Features

· Light Weight- Platform is made of high quality, light weight Acrylic material for easy portability
·

USB Port Connectivity- Unit easily connects to the computer using a standard USB cable.
·

User Friendly Software- Our software has been designed to be understood easily to ensure the
shortest time to successful Antenna Measurement.

·
Quality Components- The antenna measurement platform  is built only with the best of compo
nents for long lasting reliability.

·
Compatibility- Our Software supports a wide range of network analyzers and instruments that
use the GPIB / 488.1/2 and SCPI  methods of communication.

·
Phase/Angle Measurement-Software can measure All four Vector S-Parameters  over a
specified frequency range at each measurement point using a VNA

·
2-axis movement-  360 Degrees Horizontal at 1/8 degree per measurement  to +/- 45 degrees
vertical movement angle at 1 degree per step.

·
DC to 8, 18, 40  Ghz. Measurement Range-(depends on model) A wide frequency range
allows for a more diversified range of antennas that can be tested with the system.

·
Rotary SMA Joint- Using a high performance rotary joint the system can make accurate mea
surements without jeopardizing signal integrity.

·
Data Processing Feature-Designed for post measurement processing you can perform a range of
functions such as:

o Complete 3D Visualization for All Frequencies and Angles
o 3D Azimuth/Elevation plots for true 3D data representation.
o Ability to save and Recall Data Sets from RAM or local Disk
o Group Delay (distance calculation)
o Spherical 3D plots
o Gain Plots
o Ability to work with 4 different data sets at once
o Ability to map over 50,000 Different measurement Points onto one 3D chart
o Reference Antenna Import Feature
o Path Loss Calculator
o Dipole Link Calculator
o Calculator for modifying measurement results and comparing antennas
o Export your data to a Spreadsheet or 3rd part application such as MatLAB
o Dipole Link Simulator allows creation of simulated dipole antennas

                                                              FeaturesSystem Overview
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• AMD/Pentium Class Computer with 1.5 GHz. Processor or Higher (2 GHz or Higher Recommended)
• 512 MB Ram
• 500 Megabytes Hard Disk Space
• 1 Available USB Port
• 1024x768 Display Resolution (Minimum)
• Windows 95/98/ME/NT/2000/XP Operating Systems are supported

*Windows XP home is not compatible with the Parallel Port Model
• Keyboard and Mouse
• Compatible Network Analyzer or Power Meter/Spectrum Analyzer and Signal Generator.

As of the date of this manual the following Instruments are  are currently supported by the Standard
DAMs Software.

VECTOR NETWORK ANALYZERS
-HP/Agilent 8510x Series
-HP/Agilent 8714 Series
-HP/Agilent 8720 Series
-HP/Agilent 8753 Series
-HP/Agilent 507x Series
-HP/Agilent 836x Series PNA’s
-Wiltron/Anritsu 46xx Series Analyzers (Scorpion)
-Wiltron/Anritsu 37xx Series Analyzers (Lightning)
-Rhode & Schwarz ZVx Series

SIGNAL GENERATORS
-HP 83650 Series
-HP 8350 Series

POWER METERS
-Elva DPM-10
-HP436A
-HP437B
-ML2438A (antritsu)

SPECTRUM ANALYERS
-HP8565 Series

• Printer (optional) for printing Measured Antenna Plots

 

To Find System Information:

- Right Click on “my computer” on your
windows desktop and select Properties

Minimum System Requirements

System Overview                                                                                         Requirements
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Platform Controller Unit - USBSystem Overview

Platform Controller top view

Platform Controller rear view

The USB Platform Control unit is a highly accurate Microprocessor based stepper controller. Movement signals are
sent from the measurement PC to the controller unit where precision stepping sequences are generated. We also offer a
development kit enabling you to write your own software to control the platform.
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Control Unit Side View

Control Unit Front View

Platform Controller Unit - Parallel Port

The Parallel Port  Platform Control unit (discontinued) controls the positioning of the Horizontal and Vertical
movements based on signals received from the Computer’s Parallel Port. We also offer a Platform development kit which will
allow you to adapt the DAMS Platform to your own software using a special DLL library.

System Overview
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Upon receiving your shipment of the Rotator Unit Please inspect the package to ensure all pieces are there and not
damaged

Main components
1. Positioner Platform
2. Tripod
3. Vertical assembly
4. Vertical spacer
5. Vertical jack screw
6. 90 Deg. pivot **
7. USB Platform Controller
8. Hex wrench tools. (SAE and Metric)
9. 110/220v Power Supply with AC line cord

-Copy of your Order (Not Shown)

10. USB cable
11. Laser alignment tool **
12. 2 10’- Ultra Low loss cables SMA-M - SMA-M *
13. Platform control cables
14. Digital lnclinometer **
15. DAMS Manual / Software CD (not shown)
16. Small accessory packet (not shown)

* - DAMS 5000 supplied with Low Loss cables
**-- Optional or Inlcluded with DAMS 6000/7000
systems.

       Unpacking the  SystemChapter 1 - Installation and Configuration

Package Contents
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Tripod and Elevation Unit Assembly

The rotator unit has been shipped to you 85% assembled  in a matter that requires Minimal effort to assemble.

BEFORE YOU BEGIN: Unpack  ALL items and ensure there is no damage or missing parts.

-Vertical Assembly

1. Unfold the Tripod and extend the top of the tripod 1/2 way and secure the height adjustment- (Fig. 1)

2. IMPORTANT! Take the grey vertical spacer and snap it onto the very top of the tripod
neck(fig. 2) Without this piece your unit will not make accurate Vertical measurements.

3. Atttach the vertical assembly onto the top of the tripod using the included hex wrench so the top
edge of the vertical assembly is touching the bottom edge of the vertical spacer. (Fig 3)

Fig 1- Extend the Tripod Fig 2- Attach vertical Spacer

Fig 3- Attach vertical Assembly-
Ensure the Vertical Actuator Rod

        will have adequate clearance and
        will not hit the tripod leg.

Chapter 1 - Installation and Configuration                                                Tripod  Assembly
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 Connecting the platform and vertical actuator.

Attach the Thrust Plate using the 4 included
10-32x1/4” Screws. Be sure not to overtighten screws
and if using your own screws be sure they do not hit
the metal bearing below.

1. Ensure that the Azimuth of the
tripod is unlocked.

2.Place the Tripod head in a
horizontal position and tighten the
locking screw (Loosen screw after
assembly)

3. Align the colored piece of tape on the
platform with the tape on the tripod head
and insert the platform into the head at a
30 degree angle, the head will automati-
cally lock the platform into position.

4. Loosen the Tilt Lock (Pic 2) enough
to allow the platform to tilt and connect
the vertical actuator rod to the platform ,
tighten the locknut while holding the
HEX shaft using a wrench to ensure the
rod does not disconnect.

 Applies to Acrylic and Aluminum models.

Chapter 1 - Installation and Configuration                                             Platform Assembly

Attaching the optional thrust plate-
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Attaching the cables

You should have received 5 separate cables and a power supply with your DAMS System.

1. 2- 10 Ft. Custom Calibrated SMA cable.(1-20’ Cable Optional)
2. 1-  USB cable.
3. 2-  6m Platform control cables

Step 1. Connect the USB cable to the Platform Controller.  DO NOT CONNECT TO PC YET.

Step 2. Connect the power supply wire to the platform controller.

Step 3. Connect one end of the Calibrated SMA cable to the bottom of the platform.

Step 4.  Attach other end of SMA cable to your VNA. **USE CARE**  cable damage can compromise antenna
results.

Step 5. Connect the straight end of the yellow cable with the black band on the connector to the
“Horizontal” port on the Platform Controller and the non-banded cable to the “vertical” port.

Step 6. Connect the other ends of the yellow cables to the platform. The banded rightangle connector connects to
the turntable. And the non-banded connector connects to the vertical actuator.

Chapter 1 - Installation and Configuration                                             Cable Connections
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1. Place Software CD  in CD-ROM drive, The CD Menu should Start Automatically, If the menu does not start
automatically run setup.exe from your CD-ROM in “My Computer” or from Windows Explorer

2. Click next/OK  through all  Following Screens.

3. Before the software is finished installing , the Agilent Runtime setup will start, Continue through this setup as
you would a normal software installation.

4. After installation is complete  the Software can be found on your desktop and in the start menu
under “DAMS”

Note To NT/200/XP Pro. Users! If you using a Parallel Port Controller— You must install the UserPort
driver discussed on the next page.

Installing the Software

Chapter 1 - Installation and Configuration              Software and  Hardware Installation

Connecting the Controller and Installing the drivers. (Blue USB models Only)

1. Connect the DAMS Platform Controller to the Computer using the included USB Cable. A window
should appear indicating that a new device has been found. Do not select the option to automatically
search for the latest driver!.

2. Click the Box labelled Search Manually then click  “Next”

3. Select CD-ROM

4, Click Next, You will then be prompted that the driver has not passed the WHQL certification. Select the
“Continue Anyway” button.

5. Click Finish.

6. A new window will pop up indicating another device has been found, repeat steps 2-5 above.

8.Turn on Controller, start the DAMS Software and click the “Motor Settings” button in the bottom left corner
of the software, Make sure the USB/Serial option is selected and press the “Find” button, It should say
“Controller found on Com x”.  The USB controller configuration is now complete. If it does not find the control-
ler follow the instructions below.

Troubleshooting-
1. Check all connection between controller and PC
2. On your computer click Start -> Control Panel -> System -> Hardware Tab -> Device Manager.
3. Expand the section labeled Ports Com&LPT, you should see the DAMS Platform controller listed. and an
associated com port. If no controller is listed you may need to re-install the driver. Please contact us for
assistance.
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Installing the Userport.Sys Driver (Required for Windows NT, 2000, And XP Professional users)

NOTE: If you recieved a Pre-Configured Laptop From us, the Steps below have already been performed
-you will any need to follow the steps below if you are Re-Installing the Operating System.

Overview

This guide will Assist you with the Required Changes that must me made to windows XP Professional before the soft-
ware and platform will function correctly

Note about Windows XP: The Antenna Measurement Software Has only been tested and is only supported on the
Professional version of Microsoft Windows XP .

(LPT) Parallel Port Driver Installation Instructions:

Step 1:
The software installation has placed a Folder named “UserPort” located in the “C:\DAMS” Folder.
The userport.sys file allows the Windows XP operating system to communicate with the parallel port and control the
platform. Follow the instructions bellow to install the Userport.sys Driver.

-- For additional Information Please read the
Userport.PDF located in the Userport Folder ---

Step 2:
Setting the Compatibility mode for VEE Runtime 6.0 (XP PRO ONLY!)
 In order for the software to work absolutely correctly we recommend setting
the Windows XP compatibility mode to Windows 98/Me Mode for  less
chances of errors caused by the windows XP Kernel.

1.  Open “My Computer” located in the Start Menu

2. Open your “C:” Drive

3. Double click on the “Program Files” Folder

4. Double Click “Agilent” then double click the “Vee Pro Runtime”
Folder.

1. Go to the “C:\dams\userport\” folder and copy the
“Userport.sys” file to the windows
system32\Drivers Folder. It is usually located in
“C:\windows\system32\drivers”

2. Run the Userport.Exe program as shown at right
and Select the I/O range you wish to use and
Press Start.  (If you do not know which ports to leave
open just press start and the defaults will be used)

Chapter 1 - Installation and Configuration                                      Software Configuration
Connecting the controller and installing the Parallel Port drivers (Pre-2005 Parallel interface units ONLY)
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   5. Press the “Advanced”  button to bring up the Advanced Properties Dialog Box.
       Set the Instrument Time-out to 15 seconds. Press OK , then OK, then “SAVE”. You have now
       successfully completed the Analyzer Configuration Process.

4.     Select your analyzer from the list and click on the “Properties
button” You should see the window to the right, Change the
name that is shown to one from the list below that matches your
analyzer.

Network Analyzer
HP 8510 series analyzers
HP 8714 series analyzers
HP 8720 series analyzers
HP 8753 series analyzers
AT 5071 series analyzers
AT 836x PNA analyzers
Anritsu Scorpion Analyzers
Anritsu Lightning Analyzers
Rhode & Schwarz RS series

You must complete these steps for the Software
to communicate with your  network analyzer!.

1. Click Start -> Programs->Agilent VEE pro 7.0
        Runtime-> I/O Config.

2. Turn on you Network Analyzer and Click the
        “Find Instruments” button.

3. You should see your network analyzer appear
        in the list

The instrument number consists of the GPIB
controller ID number and the Instrument number Example:

ID (newinstrument@xxyy)
xx=Nat inst GPIB controller      yy=Analyzer ID #

4 digit format

“Name” setting
HP8510
HP8714
HP8720
HP8753
AT5071
AT8363
MS462X
ML37XX
RSZVR

VEE Runtime I/O Configuration

Chapter 1 - Installation and Configuration                                      Software Configuration

“Name” setting
HP836
HP8350

Signal Generator
HP 83650B Signal Gen.
HP 8350 Sweep Generator

“Name” setting
HP436
HP437
ML2438
ML4803
DPM10

Power Meter
HP 436A Power Meter
HP 437B Power Meter
Anritsu ML2438A
Anritsu ML4803A
ELVA-1 DPM 10

Spectrum Analyzer
HP 8565 Series

“Name” setting
HP8565
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Tripod Compatibility Information

The DAMS system has been designed so that it will operate with most any tripod, when purchasing a new tripod you
must ensure that all of the parts from the current system will fit onto the new tripod without angle or clearance problems.
Once you are ready to configure the software please read the “DAMS Application note / Tips and Tricks” for a complete
description and how to calibrate the vertical movement with a Tripod other than the one that was included with your Antenna
Measurement System. If you need Assistance you are welcome to call or e-mail us and we will be glad to help.
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Calibrating/Setting the Vertical Movement to 0 Degrees  -- See Also Vertical Calibration Settings

      In order for the software to move the platform correctly on the vertical axis  you must have the platform  at 0 degrees when
starting the DAMS Software - or the platform must match the vertical position shown in the software before moving vertically.

If the Platform Angle and Software Angle do not match, Use the Jog +/-  buttons to move the platform to the level
position,  you can change the Change jog distance by using the pulldown.

NOTE- Before clearing a measurement you will need to reset the platform to 0 degrees using the vertical slider and the
“manual move” button

Platform Positioning Test.

1. Turn on the Platform Controller

2. Make sure the platform is level , if it is not level see the information at the top of this page.

3. Start the rotator software, Click Start -> Programs -> DAMS ->DAMS x.xx

4. Click the orange “Manual Move” button located in the upper left hand section of the software. The platform should
now horizontally move the number of times specified in the “Total Number of Measurements” window completing a
360 degree sweep.

      5.  Set the Vertical Differential slider to a value of -5 degrees and press the green “Manual Move” button, the platform
should now move to -5 degrees. Slide the slider back to 0 and press the “Manual Move” button. The platform
should now return to it’s starting position.

****If the Rotator Unit successfully performed the above functions, the  rotator platform is fully functional and is ready for
Use.****

6. If The Rotator Unit does not Perform one or more of the above tests please refer to the Troubleshooting Section
located on Page 43

Chapter 1 - Installation and Configuration                                                         System Test
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SCREEN SLEEPERS and Power Saving options.
Be sure to disable screen sleepers, Power Saving Features and other
Applications, which may cause GPIB or dll to crash.

Other Running Applications-
The DAMs Software requires a large amount of CPU and System Resources. We advise you not to have any other
applications running while the DAMs Software is operating

Reporting Bugs-
During some certain complicated/untested scenarios a failure may occur, If this happens, Please let us know. We will be
able to address the problem and offer a hot fix faster if the error is reported. Please send all errors and questions about
software operation to support@diamondeng.net

Special Installation Notes

Chapter 1 - Installation and Configuration                                                Installation Notes
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Chapter 2
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Chapter 2 - Software Overview Measurement Settings

Measurement Settings

Instrument Selection and Settings

You can now choose from multiple combinations of instruments such as a Signal Generator and Power Meter or Signal
Generator and Spectrum Analyzer.

Available Modes of Operation

1. VNA ONLY
2. Signal Generator and Power Meter
3. Signal Generator and Spectrum Analyzer
4. Signal Generator and Multimeter
5. Special Receive Only Mode.
6. Emulation Mode. (Simulated Dipole Measurement)
(NOTE: Any instrument that you want to select must be
configured in the VEE I/O Configuration program prior to
selection)

Source Instrument Settings

Receive Instrument -Power Meter Settings

NOTE: These settings also apply for the RECEIVE
ONLY instrument.

Start / Stop Frequency- Enter the frequency in GHz
Decimals are OK , example: 450Mhz = .45

Number of points- Similar to a VNA configuration
you may choose the number of frequency points for
the sweep, click the “Freq Increments” window to
display the calculated Frequency Step.

Output Power- Sets the output power of the Signal
Generator. Format is dBm.

Trigger Mode- Changes the way the power meter
reads the sensor, this setting is only applied to
certain meters.

Trigger Delay- This sets the delay / Settling time
between when the Signal generator is called and the
power meter is queried for a reading. Format is in
seconds. Example: 1/10 second = .10

Sweep Delay- this sets the number of seconds the
signal generator will wait before initiating the sweep.
This allows larger antennas a chance to completely
stop moving.
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Chapter 2 - Software Overview Measurement Settings

Measurement Settings

Receive Instrument -Spectrum Analyzer Settings

Sweep Settings
Span-Sets the Frequency Span of the spectrum
analyzer sweep. Input format is in Hz.

Res Bandwidth- Sets the bandwidth window on the
spectrum analyzer , the smaller the window the faster
the sweep. Format is in GHz.

Video Bandwidth- Sets the video bandwidth window
on the spectrum analyzer

Video Averaging
Average Count- Sets the number of times the
spectrum analyzer will average the Video BW before
the data is read.

.

Triggering Options
Sequence Delay-Sets the delay time between when
the platform starts and the measurement sequence is
started

RX Delay- Sets the delay time between the time the
signal generator is called and the spectrum analyzer
is triggered to sweep.

Display Settings
Reference Level- Sets the reference level of the spectrum
analyzer display. (Settings in DB)

dB/Div- Sets the dB per Division scale on the spectrum ana-
lyzer display.Max Hold Settings

Max Hold On/Off-Turns the Max hold option on or
off.

Measure Delay- Sets how long the spectrum
analyzer will sweep and update the max hold before
sending data to the software. This function is useful
for signals that are not CW
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Degrees Per Measurement- Displays the CURRENT
degrees-per measurement based off of total degrees slider
and the degrees per measurement settings (note: This
window may indicate a different value than the pulldown,
remember this is the current setting)

Number of measurements readout- Displays the
CURRENT total number of measurements that will be made
based on the settings below.

Total Rotation Slider- This slider sets the total number of
degrees the Platform will sweep the antenna (360 default)

Degrees Per Measurement Pulldown- This drop down list
contains all of the possible degrees per measurement
combinations for the selected total rotation.

Direction- Click this button to change the rotation direction of
the platform

Manual Move- When this button is pressed the platform will
simulate the movement sequence without actually measuring
data.

Azimuth setup

Elevation setup

Vertical Slider- Use this slider to set the vertical angle that
you would like the platform to move to.

Vertical Step size- This sets the vertical measurement and
movement resolution.

Limit Check- monitor the movement of the platform to advise
you if your selected vertical movement will cause the platform
to exceed the vertical limits.

Manual Move- When this button is pressed the platform will
simulate the movement sequence without actually measuring
data.

Jog +/- Use this to set the platform to 0 degrees, the
numbers  do NOT represent degrees but direct vertical motor

Platform Settings and Calibration 

Jog Left/Right- Use these to manually rotate the turntable

Motor Settings- Contains configuration settings relating to
motor type, gear ratio and motor driver.  Please see section 1-
2 for more details.

Vertical Calibration- This button opens the vertical
calibration window  described in section 1-2 of the manual -

Import Configuration- After upgrading your software, press
this button to import your previous settings.

Chapter 2 - Software Overview Measurement Settings

Measurement Settings
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Chapter 2 - Software Overview Platform Settings and Calibration

Motor and Controller  Settings

These settings will configure the software for your specific configuration. Here you can specify the speed, controller
type gear ratio, controller driver, and acceleration, deceleration and hold settings on the newer Platform Controllers. When
choosing the “Low Gear” option the default motor speed will automatically be changed to the default value.

Select Port- Choose between USB and Parallel
port controller models. See chapter 1 to identify
your controller.

Motor Driver- If possible we recommend using
the Legacy driver , this driver usually offers better
performance but is not always compatible with
certain computers. See chapter 1 for installation
instructions for the “legacy driver”.  There is no
installation  necessary to use the “universal
driver”

Motor Resolution- This specifies the resolution
of the stepper motor installed on the platform, this
number is always 1.8 unless you have the .9
degree LIN engineering motors.

Gear Ratio- This number is the entire ratio
between the motor and the rotating platform hub.
This number is usually 7.2 for original 2 gear
system, 14.4 for new 2 belt system and 28.8 for 3
gear high res. system

Ultra High Res Option- If your platform has a
total of 3 gears on the bottom you have this
option. When this option is turned on or off the
speed settings will be changed to the default
value for that resolution option.

Move/Measure on/off- This option allows you to
turn the motors off but run the software as if you
had the motors connected to the system.

Start Speed- This will set the number of steps
per second the motor will start and stop moving
at.

End Speed- This is the maximum number of
steps per second the motor will move during
movement.

Slope- This sets the acceleration/deceleration
ramp by setting the time between the motor start
speed and the Maximum end speed. A setting of
0 will disable acceleration. A number of 1 will offer
the slowest acceleration and deceleration.

Motor Hold Option- We recommend using the
motor hold option on the HORIZONTAL axis to
ensure the platform does not move on it’s own
between movement sequences. The vertical hold
should only be enabled when using a heavy load
that causes the lead screw to move on it’s own.

Move left/right/up/down- After you have made a
change to the acceleration setting you may test
them using the move buttons.
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Chapter 2 - Software Overview Platform Settings and Calibration

Vertical Calibration Settings

These settings will configure the vertical axis calibration. The design of the vertcal  axis requires a number of calibra-
tion contents that are sometimes specific to a particular unit. Your unit will have a sticker that has all of the parameters
either on the control box or the platform itself. If your sticker only has 2 numbers ex. 2083/3.99 , these are the values in the
GREEN section of the calibration menu and you do NOT need to change any of the numbers in the RED section. Simply
enter your numbers in the windows and press save then use the “QUIT” button in the software and restart the software to
activate the changes.
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Chapter 2 - Software Overview Scalar Calibration Settings

Calibration  Settings

Scalar Calibration

This feature enables you to make a scalar calibration using your Signal Generator and Receive source. An in depth
explanation and example is located in chapter 3 - Calibrating your system.

Averaging- in cases of large amounts of
background noise you may want to
average the calibration measurements.

Save Cal- Save your calibration to a file
on your computer.

Load Cal - Load a calibration file from
your computer.

Pad (dB)- if using a post amp with
attenuator , you need to enter the attenua-
tor value in this window.

Power Head Cal- This button invokes the
power sensor cal menu.
(NOTE: If using a power meter with Non-
Programmed sensor You MUST load or
enter a Power Sensor cal table before
performing a scalar calibration)

Power Sensor Calibration

The Power Head / Sensor calibration menu is located in the Scalar Calibration section.

Enter PM cal factors-  you can enter the
calibration table directly to check compat-
ibly

Compile Array- Compile the manually
entered Cal factors and display them on
the chart below

Load Cal - Load a calibration file from
your computer.

Load from Notepad File- Load a file
containing a Cal-Factor lookup table.

Sample notepad file- This file shows
you how your Cal-Factor notepad file
needs to look

Test- Enter a frequency within the value of
the cal factor table and you will see the
corresponding exact Cal-Factor in the
“Calculated CF” window.
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Measurement Controls

Post Measurement Options

Measure Horiz. Sweep- When this button is pressed, the software will begin making measurements by moving the platform
horizontally , then retrieving the data from the network analyzer. The button will remain “grayed out” while the antenna
measurement is in progress

Measure Vert. Sweep- When this button is pressed, the software will begin making measurements by moving the
platform horizontally , then retrieving the data from the network analyzer. The button will remain “grayed out” while the
antenna measurement is in progress

Scan VH- When this button is pressed, the software will begin what is called a scan sweep, the software will make a
complete horizontal measurement then move to the next vertical position and make another complete horizontal sweep.  This
process will continue until the platform reaches the ending vertical position.

Reset Accumulator- When this button is pressed, the software will begin making measurements by moving the platform
horizontally , then retrieving the data from the network analyzer. The button will remain “greyed out” while the antenna
measurement is in progress

Move to Max Signal - When this button is pressed, the software will analyze the measurements you have just made
to find the position where the antenna had the maximum gain , the software will then move the antenna to the
maximum signal position.

Proceed to Data Processing- Once you have completed making your measurements and you click this button you
will be taken to a section of the software that will allow you to view/manipulate any part of the measurement. The Data
Processing section also allows you to view the data in many different formats including , Polar, Mag, and 3D

Export Reg 0  - When you have completed a measurement you can instantly export the data set to an outside file
for the ability to import the data into a spreadsheet or use in a 3rd party plotting or processing program.

Measurement ControlsChapter 2 - Software Overview
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Measurement Status and Displays

Measurement Status window

Graphical Status Displays
The Graphical status windows allow you to view the Real-Time data as it is captured from the Network Analyzer. All Status
Graphs display the center measurement frequency.

Center Frequency Amplitude Plot- This plot displays the Amplitude in dB of the measured Antenna.

Antenna Polar Radiation Pattern-  This plot displays the Real-Time pattern of the measured Antenna

High Res Plot -  Display a high resolution MatLAB Polar plot of your measured Antenna at the Center Frequency.

Rotation Tracker- This plot shows the current position of the platform, the Horizontal Axis is shown with circular data
points, and the Vertical movement is shown with data points on the center plane of the plot.

Clear Plot- Each plot has it’s own “Clear-Plot’ button , this will clear all current data from the plot

The measurement status window displays all of the current Measurement parameters and will update automatically
During the measurement process.

Chapter 2 - Software Overview

Measurement Status and  Displays
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Data Processing Introduction

The Data Processing Feature is your gateway to unlocking the data contained within your antenna measurements.
After making your initial measurement of the Antenna you can press the “Data Processing” button located in the “Post
Measurement Options” window of the main software page and you will be taken to the screen shown below.

This section of the manual will describe all of the functions located in the Data Processing feature.

Data ProcessingChapter 2 - Software Overview
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Data Registers
When working with data in the Data Processing feature all of the data is stored in registers, these registers allow

you to have “Holding Space” for particular data sets. This is very useful for working with multiple measurements from other
antennas. There are 5 registers total, 4 storage registers and 1 Active register.

Active Register

Once you have completed a measurement and open the Data Processing Feature, The entire data set from your
measurement will automatically be placed into the “Active” Data register. The Active register is applied to all functions
including 3D plots and Data Export functions. With the exception of the Measurement Calculator which can pull data from
any of the 5 registers.

Data Registers

Data Storage Button- When this button is pressed , all of
the data in the Active Register is stored to whichever
storage button that you chose.

Recall Button- When this button is pushed , all of the
data in the chosen storage register will be written to the
active register for viewing or modification.

Load Reg 1-4 From Disc- This button will load a set of 4
registers from the disc.

Save Reg 1-4 To Disc- This button will save a set of 4
registers to the disc.

Clear All Registers- This button will clear all data from
registers 1-4.

The Data Storage Registers offer space to put up to 4 different measurement sets that you can recall at any point in time,
you can also save the entire set of 4 registers to disc for use at a later time.

Chapter 2 - Software Overview                                                                 Data Processing
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Visualization Options

The data visualization options enables you to view the Antenna Data in a wide variety of formats.

Azimuth vs. Frequency vs. Amplitude 3D Plot

Azimuth vs. Elevation vs. Amplitude 3D Plot

About:  This plot is the most versatile of the 3D plots and
will give you a good idea of the frequency response Vs.
Rotation of the Antenna you have measured . If you have
made AZ/El measurements you can use the AZ/El 3D plot
for a more detailed view.

Features
View entire data set at once
Full Plot Rotation
Zoom In/Out feature
Line and Notation Tools
Exportable to common graphic formats
Printable

About:  After you make a AZ/El measurement you can view
the Azimuth vs. Elevation for any measured frequency using
the AZ/El 3D Plot use the Azimuth Vs Frequency 3D plot to
view frequency response to aid in the selection of the single
frequency.

Features
View AZ/El Data for any Frequency point
Full Plot Rotation
Zoom In/Out feature
Line and Notation Tools
Exportable to common graphic formats
Printable

Chapter 2 - Software Overview                                                                Data Processing
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Spherical 3D Plots

   About:  When a H/V scan measurement is made you can plot the data in true 3D up to the extents of your measurement.
This data can be viewed in true 3D, mapped onto a sphere, and even compared to an ideal Iso-sphere or dipole right on the
same plot. REMEMBER- Sphereical plotting will only work with AZ/EL measurement data loaded into the Active Register.

General Spherical Plotting Features

Data Plotting Options- These items change how the
measured data is displayed in the plot window

Iso-Sphere- Generates a true Iso-Sphere on the
same plot as the measured data

Dipole Generator- Generates a spherical dipole plot
on the same plot as the measured data.

Frequency- Choose the frequency that you want to
plot.

Generate Plot- After configuring your display
options, press this to generate your plot.

Spherical Plot Examples

Chapter 2 - Software Overview                                                                Data Processing

Standard Spherical Spherical over Iso-Sphere Parabolic Dish

Map to Sphere

Map to Sphere over Freq.

Map to Sphere with Grid
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Dynamic Amplitude Plot - Invoked from Polar Plot window

Dynamic Polar Plot

Group Delay Function

About:  This plot is a sub-function of the polar plot. This
function allows you to view the amplitude while adjusting the
sliders in the polar plot window.

About:  This plot offers a Linear or Log Polar 2D look into
the Rotation Gain Pattern of the measured Antenna for a
specified frequency point.

Features

About:  This features allows the analysis of the Group
Delay and Path Propagation Data. You can also make an
accurate measurement of the antenna distances using
this feature.

Features

Distance Scale Functions
Data Export
Auto Scale Function
Printable Plots

Chapter 2 - Software Overview                                                                Data Processing

Linear or Log Format
Multiple Scale Options
Automatically updates
Keep Max Function
Data Export
Auto Scale Function
Zoom In/Out

Dual Trace Plotting
Dual Markers
Marker Delta and Gain
Vertical or Horizontal
Printable
Find Max Signal
Zoom In/Out
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Measurement Calculator

Use this option to perform arithmetic operations on the measurement registers. For example if you make mea-
surements on one antenna and wish to compare the results to another antenna at each point of rotation and each fre-
quency. Or if you have a calibrated reference antenna an wish to normalize additional measurements to the max or min
value of the reference antenna. Remember all measurement data is linear so you may want to “LOG” the data before
doing math. If you select MAX or MIN then all measurement elements will be replaced with MAX or MIN. This creates a
normalization reference if you do your math correctly.

Dipole Link Simulator

Vertical Swing Correction

Chapter 2 - Software Overview                                                                Data Processing

The Dipole Link Simulator is used to create ideal dipole
measurements based on a set of physical and environmental
factors. These calculated measurements can be imported directly to
the measurement calculator for comparison with Measured Data.

The Vertical Swing Correction
tool is used to compensate for the tilt
of the platform when making Vertical /
Elevation Measurements.
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Performing a Scalar Calibration when using Source / Receive Configuration

1. Ensure platform Power supply  is securely attached and plugged in and connected to your VNA using the supplied
SMA cable.

3. Turn platform controller power ON.

4.    Select the Source Instrument you plan to use (ex. HP83650) , After selection click the “Settings” button located
       below the icon to configure parameters for your measurement (start , stop , number of points , etc.)

5. Click the “Cal System button

6. Connect the power meter to the top of the DAMs System.

7.   Follow the on screen directions.

Chapter 3 - Making Measurements System Calibration

Performing a Scalar Calibration when using a VNA configuration

1. Ensure positioner is connected to the controller and also connected to your VNA using the supplied RF cable.

3. Turn platform controller power ON.

4.   Configure your VNA for desired Start/Stop/No Points.

5. Click the “Cal System” button

6. Connect the end of the cable going to your Reference Antenna. To the top of the DAMS platform.
(NOTE: If using an amplifier be sure to attenuate the signal to avoid exceeding the maximum input power on your
VNA.)

7.  Set the pad value to 0 unless you are using an amplifier

8.  Press the first “Begin Calibration” button, you will see the loss data display in the small window to the upper left.

9. Press the second “Begin Calibration” button. The loss data will be displayed in the upper right window.

10. You may now save the calibration or just click “exit” where you will be prompted to apply the calibration data to your
measurements.
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Making a basic Horizontal/Azimuth Measurement

1. Be sure Platform Power supply  is securely attached and plugged in

2. Attach antenna to rotator platform with SMA connector

3. Turn Platform Power ON.

4.   On your analyzer select S21, POLAR Plot and the proper Calibration set Example: 4 to 6 GHz @ 201 Points.
*if your analyzer has not been calibrated, you need to follow the calibration procedure listed in chapter 1

5.  Select the total Number of degrees you want the platform to move using the “Total Degrees Slider”, the total
amount will be shown in the slider window.

6. Select the “Degrees Per Measurement” setting of your choice using the associated Slider.  The “Total number
of measurements” window will be updated once a selection has been made.

7. Select your Direction using the CW/CCW selection

8. Press the “Measure Horiz Sweep” Button to start the measurement Process

9. During the measurement process you will see the Rotator Platform moving and center frequency data starting to
appear on your screen. The “Measure Horiz Sweep” button will remain greyed out for the duration of the
measurements. Once the button has returned to its normal state you may enter the “Advanced Processing” section
or perform other Post Measurement options.

Chapter 3 - Making Measurements  Basic Measurements

Making a basic Vertical/Elevation Measurement

1. Be sure Platform controller is turned on and connected.

2. Attach antenna to rotator platform with SMA connector

3. Start the DAMS Software.

4.   On your analyzer select S21, POLAR Plot and the proper Calibration set Example: 4 to 6 GHz @ 201 Points.

5. Be sure the platform angle matches the position displayed on the screen, if it is not correct refer to the vertical
calibration information located on page --

6. Set the vertical position slider to the desired start position and press the Manual Move button, this will move the
platform to the beginning Elevation position.

7. Select the desired stop position on the vertical slider.

8. Press the “Measure Vert Sweep” Button to start the measurement Process

9. During the measurement process you will see the Rotator Platform moving and center frequency data starting to
appear on your screen. The “Measure Vert Sweep” button will remain greyed out for the duration of the
measurements. Once the button has returned to its normal state you may enter the “Advanced Processing”
section or perform other Post Measurement options.
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Chapter 3 - Making Measurements  AZ/El Scan Measurements

Performing an AZ/EL Scan Measurement

1. Be sure Rotator Power is Securely attached and plugged in

2. Attach Antenna to rotator platform using a SMA connector, NOTE: For
directional antennas we recommend starting with the max gain point of
the antenna 180 degrees from the source antenna.

3. Turn Platform Power ON.

4.   On your analyzer select S21, POLAR Plot and the proper instrument
      state -Example: 4 to 6 GHz @ 201 Points.

5.  The Total Degrees Slider must be set to 360 degrees or the software will not sort measurements correctly.

6. Select the degrees per measurement using the degrees per measurement pulldown, the total number of
measurements will be shown above the pulldowns.
*remember the total number of measurements you select is multiplied by the number of elevation measurement
points, this will cause large files and may cause problems for some computers depending on resolution)

7. Select your Direction using the “CW/CCW” selection

8. Move the platform to the Elevation start position using the vertical slider and the “Manual Move” button.
      (If the vertical position of the platform does not match the software readout - level the platform first, Pg. --)
9.   Set the Vertical movement slider to the desired elevation stop position.

10.  Press the “Scan AZ/EL” button to begin making measurements.

11. During the measurement process you will see the Rotator Platform make a complete horizontal sweep then
move to the next desired elevation point and will repeat the horizontal sweep.  You should also see some data
starting to appear on your screen, The Scan AZ/EL button will remain greyed out during the measurement process.
Once the button returns to it’s normal state your measuring process is complete and you may continue on to Data
Processing.
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Chapter 4 - Using the Data Processing Feature

Introduction

Use the Data Processing section to work with the data you collected after you make any Antenna Measurements.
This feature allows complete control over the data including the ability to completely manipulate the data using a large set of
math operators as well as compare the current antenna to another Antenna or a calibrated reference antenna. A complete set
of plotting options allow you visualize your data in a multitude of  formats. This section of the manual will assist you with
getting the most out of your Antenna Measurement System.  If you are not familiar with any of the terms mentioned in this
chapter , please refer to the Software Overview located on page.

Data Processing Screenshot
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Saving and Loading Measurement Data Sets.

All measurement data is stored in “data storage registers”  each Data Set consists of a group of 4 Data Registers.
These 4 Registers are used only for storing and recalling data within the Data Processing feature, the Data Sets  can be
recalled or saved to disc at any point in time.  There is one register called the “Active Register” this will contain your current
measurement or any loaded measurement,  Any plots, graphs, and export features will be based off of this register, but this
register is considered “temporary” and will not be saved to disc, any Active Register data that you want to save must be
placed into one of the 4 Data Registers.

 Once you enter the Data Processing section after making an Antenna Measurement, all of the measurement
data will be placed in the “Active Register” . To save this data you would click the button labeled “Data Storage Reg 1” this
will place all of the active register data into Data Storage Register 1 and cause a red * to be places next to that data
register. To save this data set to the hard drive you would press the “Save Reg 1-4 to disc” button.

Data Storage Button 1-4- When this button is pressed ,
all of the data in the Active Register is stored to whichever
storage button that you chose.

Recall Button- When this button is pushed , all of the
data in that storage register will be loaded into   to the
active register for viewing or modification.

Load Reg 1-4 From Disc- This button will load a set of 4
registers from the disc.

Save Reg 1-4 To Disc- This button will save a set of 4
registers to the disc.

Clear All Registers- This button will clear all data from
registers 1-4.

Quick Tip : After entering Data Processing Immediately press the “Data Storage Reg 1” button to keep the original
measurement data available

Data RegistersChapter 4 - Using the Data Processing Feature
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Viewing and working with  measurements in 3D

Press any of the 3D Buttons to View the “Active Register” Data in 3D Using the MatLAB Viewing Interface.

Viewing 3D Azimuth Measurements

Viewing 3D AZ/El Measurements

1. Be Sure there is data in the “Active Register, if there is no data
you must recall data from one of the storage registers or make a
Measurement.

2. Press the “View 3D AZ Plot” button.

3. Depending on the size of your measurement and the speed of
your computer it may take up to 2 minutes for your 3D plot to
appear on the screen.

1. Be Sure there is data in the “Active Register, if there is no data
you must recall data from one of the storage registers or make a
Measurement.

2. You can only view 1 frequency at a time using the AZ/El 3D
Plots, when you press the “View 3D AZ/El” measurements you will
be prompted to choose a frequency to view.

3. Depending on the size of your measurement and the speed of
your computer it may take up to 2 minutes for your 3D plot to
appear on the screen.

QUICK TIP: Use the Amplitude plot to get a reference of the
frequency response of the antenna.

Working With 3D Data

To Rotate a Plot- Click Tools -> Rotate 3D

To Print a Plot-   Click File->Print

To Label a Plot-  Click Tools -> Add -> Text

To save a Plot-   Click File -> Save (Saved File compatible with MatLAB viewer only)

To Export as BMP Image File-  Click File -> Export

Below are a few common functions that you can do with the 3D plots.

Plotting DataChapter 4 - Using the Data Processing Feature
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Plotting DataChapter 4 - Using the Data Processing Feature
Dynamic Polar and Amplitude Plots

1. From the Main Data Processing Page click on “Polar/Amplitude Plot” and you will be taken to the
screen shown below

2. REG0 will be loaded automatically, use the REGx buttons to select different data sets.

3. Use the sliders to browse through the dataset.

4. The Lin/Log , DB/DIV, Separation values can be set to desired settings.  NOTE: if you have already
calculated the path loss and applied it to the antenna you want to keep this feature UNCHECKED

5. Markers located in the center of the plot can be dragged to different areas of the trace, the resultant
amplitude and angle differences will be displayed in the large numerical windows at the bottom.

6. To Export the current trace data to a file click the “Export” button.

7. To save the entire plot with the number labels you must use the windows screen capture function by
pressing the “Print Screen” button on your keyboard , then paste the image into an image editing
program where it can be further labeled and printed.

8. Click the “Gain Plots” button for detailed instructions. More advanced procedures such as working
with dual trace plots are discussed in the Advanced Techniques application note.

Polar Plot/Amplitude plot Screenshot

The Polar and Amplitude plots allow you to view the Horizontal or Vertical sweep data over specific frequencies and/
or elevations. The Polar and Amplitude plots have been combined to use the same control panel. Simply select the frequency
and elevation (if applicable) and the data will be instantly displayed on the plot. Press the “Amplitude Plot” to view the
amplitude plot , press the button again to close the plot.

QUICK TIP: Right-Click the plot to see a list of visualization options such as zoom, and scaling functions.

Instructions:
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Reference and Path Loss DataChapter 4 - Using the Data Processing Feature

Importing reference antenna data and calculating path loss.

After you have made your antenna measurements and have entered the Data Processing area you may now
import your Reference Antenna data and Path Loss data for the measurement that you just made this data can be directly
applied to your measurement or you can save it in it’s own register for later use.

Importing reference antenna data

You can enter all of the gain values for a specific reference antenna into an appropriately formatted text document.
The software will read and interpolate these values across the entire measurement frequency range of your measurement and
place the values into the Active register, the calculator can now be used to apply the reference data to your register
containing the original measurement data. See the REFhorn.txt file located in c:\dams

Instructions:
1. Make your antenna measurement and proceed to the Data Processing section.
2. Store your measured data into REG1
3. Click the “Import Reference” button
4. Click the “Load from notepad file” and select your reference data file.
5. Wait until you see “Data loaded into REG0” appear and press “continue”
6. You now have your measured data in REG1 and your reference data in REG0 (active register)
7. From this point you can do a number of functions but we will focus on just applying the reference data to
your measurement and placing it into REG2 using the calculator.
8. Set the following items in the calculator from left to right: REGx, REG1, / , REGx, REG0. then Press “=” ,
the calculator has processed the information and placed it in the active register (reg0), store the data into
REG2 and now you have your original data in REG1 and your data with the reference data in REG2.

Example reference data for a 1-18 GHz horn. FORMAT:  frequency(in ghz) (tab) gain value

1 6.7
1.5 8.7
2 7.3
2.5 8.1
3 8.9
3.5 8.7
4 9.6
4.5 9.6
5 8.7
5.5 9.4
6 9.4
6.5 9.7
7 9.6
7.5 9.8
8 10.4
8.5 10.6
9 11.3
9.5 11.1
10 11.6
10.5 11.3
11 10.9
11.5 10.6
12 11.6
12.5 11.2
13 11.7
13.5 10.8
14 11.2
14.5 11.1
15 12.2
15.5 12.9
16 12.5
16.5 10.7
17 9.8
17.5 9.4

18 9.3
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Reference and Path Loss DataChapter 4 - Using the Data Processing Feature

Calculating and applying path loss data.

You can calculate the loss for the given distance between two antennas using the path loss calculator. This process
is nearly the same as importing reference data. The instructions below will show you how to simply apply the path loss data
to your measurement and save that data into a new register.

Instructions:
1. Make your antenna measurement and proceed to the Data Processing section.
2. Store your measured data into REG1
3. Click the “Calculate path loss” button
4. Enter your desired distance into the window and select your designator, the press calculate
5. Wait until you see “Data loaded into REG0” appear and press “continue”
6. You now have your measured data in REG1 and your path loss data in REG0 (active register)
7. From this point you can do a number of functions but we will focus on just applying the path loss data to
your measurement and placing it into REG2 using the calculator. NOTE: if you already have calculated the
reference antenna data , you have the option at this point to divide REG2 by REG0 instead of performing the
steps listed below.
8. Set the following items in the calculator from left to right: REGx, REG1, / , REGx, REG0. then Press “=” ,
the calculator has processed the information and placed it in the active register (reg0), store the data into
REG2 and now you have your original data in REG1 and your data with the path loss data in REG2.
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Using the Measurement Calculator / Register Math Function.

Understanding the Register Math Functions

Measurement data is initially stored in the Active register when you leave the main software page and enter the advanced
processing section. When you proceed to the Data Processing Feature you have a choice of 4 additional registers in which
to store Reg0.

The measurement format is:
                         dataReg0-4[Mag,Phase,(Hpos,Vpos),0/1,freq]

Each time you press the Reg calculator  =  sign the results are save to the Active Register. You can then save those
results to any one of the 4 original Regs. Be sure to have saved the original to disc as it will be over written.

Use this option to perform arithmetic operations on the measurement registers. For example if you make
measurements on one antenna and wish to compare the results to another antenna at each point of rotation and each
frequency. Or if you have a calibrated reference antenna an wish to normalize additional measurements to the max or
min value of the reference antenna. Remember all measurement data is linear so you may want to “LOG” the data
before doing math. If you select MAX or MIN then all measurement elements will be replaced with MAX or MIN. This
creates a normalization reference if you do your math correctly.

Register Math / Calculator Screenshot

Linear  :    When highlighted the Reg# to the right is to be used as S21 in vector format Arithmetic is performed
using vector components

LinearMag :  When highlighted the Magnitude of Reg # to the right is to be Logged (dB) and used as a scalar array
in all arithmetic operations. The angle information is remains in the original Reg# but is lost in the calculator.

LOGmag:     When highlighted the Reg# to the right is to be used as       10LOG(S21^2) in scalar format The
frequency S21 angle information remains in the original Reg # but is lost in the calculator.

^2 :    When highlighted the Reg# to the right is to be used in complex format and squared

SQRT :  When highlighted the Reg# to the right is to be used complex format ^(1/2)

 Max :     When highlighted the Reg# to the right Maximum Linear value is to be used in all matrix arithmetic. This
provides a good way to normalize measurements. The  frequency S21 angle information remains in the original Reg#
but is lost in the calculator.

 Min :      When highlighted the Reg# to the right Minimum Linear value is to be used in all matrix arithmetic. This
provides a good way to normalize measurements. The  frequency S21 angle information remains in the original Reg#
but is lost in the calculator.

Constant  :>   Use the constant option to +-/* a constant to the first register set (left) This is useful when you wish to
add level shifts such as 3dB for HV polarization measurements not accounted for anywhere else.

Math Functions

Data Processing FeatureChapter 4 - Using the Data Processing Feature
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Using the Measurement Calculator / Register Math Function.                                              Contd.

Clip Function

Use this to create a threshold level. A ZERO value clip causes software to ignore clipping and resume normal calculator
mode.
For example lets say the you wish to not include data points smaller than some low level value such as <-50dBM.

Enter the value -50 into the constant window Understanding the Register Math Functions and highlight “Clip”. This will
operate on only the data from the first set (left of the +-*/). Any magnitude values LESS that the clip value will be set
EQUAL to the clip value.

Notice: the plotting functions will be affected by the clip value. Use this to scale and expand the plots. Notice also that
the calculator can be used to change the plot scales from linear to log or to add offset to measurements.

TERM 1 MULTIPLIER         Works with
      LINEAR                        +,-

      linMag                        +,-,*,/
      LogMag                      +,-,*,/

TERM 2 MULTIPLIER  All functions above plus Constant

IMPORTANT: Not all combinations of Math are possible. Be sure you
have the same size data array

Data Processing FeatureChapter 4 - Using the Data Processing Feature
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Exporting Data

Measurement Export Process

!  Saturday July,16  2005
             !    Freq= 896MHz   Elevation = 0

!      Azimuth     S21mag   S21ang
         0        0.0169    86.8
         5        0.0146    81.6
         10       0.0151    82.9
         15       0.0141    81.4
         20       0.0135    81.9
         25       0.0129    82.4
         30       0.0123    82.8

      35       0.0114    84

Front page export information.

Exporting DataChapter 4 - Using the Data Processing Feature

     The DAMS software offers you 2 sperate ways to export your data. We refer to them as the “Front Page Export” which
will export your entire measurement set over the entire horizontal/vertical axis and over frequency and the “Single
Frequency” export which can be found in the “Polar and Amplitude” plot function in the Data Processing section.

NOTES:

1. When using the front page export we recommended using 51 points or less and keeping the degrees per measurement
set to 5 degrees.

2. To export using the single frequency export function simply open the Polar/Amplitude plot and select the frequency and
vertical angle (if applicable) of your choice and press the export button, select the name and location you want to save to
and press the OK button to save the data, you will be shown the resultant export file as well.

Sample single frequency export (available in the Polar/Amplitude Module)

Adata is your measurement data array in complex format from the basic page 1 software

The first column is a scalar array and can set the count for example “frequencies” or angle. You can do this in one of two
ways. Enter a known one dimensional array variable such as “NumM”. The program variable “NumM” is a 1-D array
otherwise only a single row will be written. The number of elements  in the NumM array will set column 1 variable “Scalar”
(number of data ROWS). Column1 “Scalar” array is automatically set
from the variable you enter into the window unless you press one of the other two Set Scalar buttons.

Make your own Scalar array.  Enter the Start, Stop, NumPts such as
Frequencies in the windows below the Scalar switch. Remember if switch is in the up position Scalar will still be used for
the  number of rows but not written to the  output file.

Notice there is also a SET SCALAR button below column 2. You may choose to set the number of rows using the size of
column 2.
This will set Scalar and if Scalar is present in column 1 window and switch 1 isin the down position then the output file will
include the row count or whatever.

Any one of the switches in the up position will skip that parameter in the output file. Note that for basic Antenna rotation
measurements the frequency is constant while the path loss and angle is the program measurement complex variable
“Adata”. I you wanted to create a text
based output file for a spreadsheet which contains the results of a rotation and measurement set then set all switches to
the up position except for switch 2 (or 3 or 4 or 5). Then enter Adata into window 2 below switch 2. Press the Set Scalar
button in column 2. Then export the data. The resulting text file will contain two  columns. Column 1 = Magnitude and
column 2 will contain the position. Open the file with Note Pad and use copy & paste to transfer into spreadsheet. If you
wanted column 1 to contain the row count then use Set Scalar in column 1. Enter the number of measurements (n)from
page 1 software (in the slider window) and a start stop(n) number. Then export.
Notice that there are “From Variable”  “From Disc” check boxes below each Complex switch. When From Variable is
checked the data is retrieved from the variable in the box below the switch at the time of export.
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Using the Dipole and Isotropic Link Calculator-

Use the ideal dipole to simulate an entire link measurement set. Then you may perform calculator operations that you
can use to normalize and compare your measurements to.
The calculations are for any dipole length over any frequency range for any rotation sequence. Be advised the
calculation can become enormous if you
choose a very long or very short lengths compared to a wavelength. The Si and Ci sin(x)/x and cos(x)/x intergrals are
numerically calculated.

It is important to understand how the link works. The
dipole current is sinusoidal. The current is assumed the
same over all frequencies.

The radiated power at all frequencies is the same. If
Imax is to be constant over the frequency band then the
total radiated power changes with RadR. Maintaining
Imax with frequency requires an imaginary tuner
between the dipole and the VNA... Once you have
calculated the Tx dipole gain you must complete the link
by defining the receive aperture. If you save the dipole
gain to a REG and perform a plot function you may see
that the dipole gain peaks at frequencies other than the
1/4 wave frequency. This is because you must multiply
the dipole gain by the apertures at distance.

Think of the aperture as the hole through which the
dipole radiated power is received. The effective hole
area is inversely proportional to frequency or 1/f^2 in
power.

After each calculation return to the advanced menu and store the results into Re1 and Reg2. Note that these results are
linear power.

If you are planning to compare your link measurements to this ideal dipole link
then you need to set the frequency and rotation start, stop, &step to the same values.
Set the PTx(dBM)to your VNA power + DAMs loss. Make sure the number of VNA measurement points are the
same. This matches the data matrix dimensions and extents with your actual measurements.

The dipole will simulate an entire measurement set, performing rotation and measurements at each point. It is
assumed the dipole has been matched (S11=0) at each measurement.

You should try a few calculations to get a feel for the CPU time involved before actually making
measurements. Once the calculations are complete the calculate button reappears. You may exit the
process  at any time if you get tired of waiting. The plot of radiation resistance appears first. After which the
pattern calculations progress much faster. This results in one gain(f,Angle).

Note the results are  linear not dB. From this point you will want to store these results in a REG.

Then you must decide how to define the Rx antenna and use the calculator to calculate the classical link
equation.

Calculate the Rx Aperture. Use this to calculate and fill
the frequency array with the area aperture equation for use with the receive antenna.

Chapter 4 - Using the Data Processing Feature Data Processing Feature
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Once you have saved your dipole array into REG1 (or 2,3,4) calculate the Aperture array and save the results into  REG2.
Now use the calculator to multiply REG1 x REG2. The result is the entire link gain normalized to
the Rx antenna gain.

Save the results into a REG3. Now choose a receive antenna. You could go back into the dipole section and calculate
another dipole for Rx.
Save these results into REG4. Multiply  REG4 X REG3. This gives the entire path gain over Tx rotation and frequency.

********—THE Rx Aperture—  If the Rx antenna is isotropic (GRx=1) then the “Calculate Rx Aperture” is the receive power
for two isotropic radiators (one Tx and one Rx) at distance R. It is as the figure  above except that each dipole is replaced
with an ideal infinitesimal isotropic antenna where the Tx radiator is fed with the PTx power (converted to linear)

********—ABOUT PHASE— The phase angle for the dipole is in absolute degrees. This makes it easy to
calculate group delay

Using the Dipole and Isotropic Link Calculator                                                                    Contd.

  Chapter 4 - Using the Data Processing Feature Data Processing Feature



55

Data Processing Feature
Group Delay Function

Group delay is the derivative (slope) of the transmission phase angle. For passive circuit elements the group
delay is linear and may be calculated from two measurements. It is important that the ratio of the frequency delta-
wavelength is less that the physical distance between the measurement. If this is not the case then either the frequency
Resolution must be increased or the delay will need to be integer scaled. The scale integer is INT(d/wavelength).
Wavelength is that wavelength associated with the difference frequency (or step frequency). Periodic spikes will occur in
the group delay plot. Non-periodic spikes represent the Multipath or some other source of distortion.

Be advised this software does not perform vector corrections for free space measurements. The corrected group delay
is applied only toThe display. Use the EXPORT button on the display to save the display values to disc. Note that if you
made measurements and saved them to the disc or into a Reg that they will NOT be corrected for system delay but
WILL be corrected for system loss. You Should note this in your file Document item to avoid incorrect displays or re-
save. To correct the group delay (locally) check the radial “Correct for system delay” (left). The plots will automatically
update allowing you see both the corrected and uncorrected profiles.

Group Delay Screenshot

Chapter 4 - Using the Data Processing Feature



56



57



58

Troubleshooting

Problem- Green light on controller is not on
Possible Causes- Power Supply is not connected correctly, Power Switch is not in the ON position
Solution- Check all of the Items listed above and if everything is OK and light still does not come on please contact us
immediately for service.

Problem- Green light is on but positioner does not move
Possible Causes- USB cable not connected, driver is not installed or  Improper port selection in DAMS software
Solution-Check all connections, reboot computer, Click “motor settings” in DAMS software and click “Find”

Problem- Only one axis is moving
Possible causes-  Loose cable connection, controller error
Solution- With the controller off, disconnect and reconnect yellow cables.

Problem- ERROR: Driver for (instrument name) not found , use instrument manager to add it.
Possible Causes- Your instrument is not configured properly in the Agilent VEE Runtime I/O configuration
Solution- Read instrument configuration instructions.

Problem- Analyzer does not initialize on Program start/Program Crashes with ID error
Possible Causes- Analyzer ID is set incorrectly, Missing Instrument Driver, GPIB Card/Bus is not working correctly
Solution- Using Vee-Runtime I/O manager verify the ID number is set correctly. And run the GPIB Pre-Test to verify
Connectivity.

**If you are experiencing any of the above problems or an unlisted problem  and cannot determine the cause, please
contact us as soon as possible so we can resolve any issues.

Chapter 5 -  Troubleshooting and Service Troubleshooting Operation
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Warranty Information

The Antenna Measurement System is guaranteed for 2 years on parts and labor from the time it was received by you. If
there is a problem with the product please send us a picture or write a very detailed description of the problem, If we
determine that you have a faulty unit or bad part we will ship you a replacement part or unit with a self addressed box to
send the defective unit back with

Replacement Parts

If you ever need a replacement part for your rotator unit, Please call us or e-mail us for faster response and pricing
information. Most Repairs are covered under warranty except for damages resulting from obvious abuse or misuse of the
product

Contact Information

Visit us on the Web at Http://www.DiamondEng.net

Main Headquarters

Diamond Engineering
P.O. Box 2037
Diamond Springs, CA 95619
Phone- (530)626-3857
Fax- (530)626-0495

Administrative and financial questions
Name- Mike Hillbun
Email- mikehill@diamondeng.net

Technical Support and Warranty
Name- James Martin
Email- James@diamondeng.net

Chapter 5 -  Troubleshooting and Service Service and  Contact Info.
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Addendum- Model 6000-100 Setup Guide Introduction

The DAMS 6000-100 Antenna Measurement System Features a 100lb. capacity positioner with extra heavy
duty tripod for measuring frequencies up to 18 GHz. This system uses the same software as the other 5000, 6000,
and 7000 models.  This guide has been provided to assist with the understanding, setup, and operation of the
6000-100 system. All other instuction such as using the software and making measurements is covered under the
regular users manual provided to you with this system.
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Addendum- Model 6000-100 Setup Guide Whats Included

Upon receiving your shipment of the DAMS 6000-100 Verify that you received all of the items below and check for any
damages that may have ocurred during the shipment process. Please contact us immediatly if any items are missing or
damaged.

Package Contents

List of Parts
1. 100lb Positioner
2. 2- 10’ Ultra Low Loss Cables
3. Positioner Power/Data Cable
4. Tripod Adapter Plate
5. USB Interface box
6. USB Cable
7. 24V Power Supply
8. Hex wrench tools. (SAE)
9. Loctite, SMA Saver, Additional Hardware

10. Digital Level
11. Laser alignment tool **
12. Heavy duty tripod
13. Thrust Plate
15. DAMS Manual / Software CD (not shown)



63

Addendum- Model 6000-100 Setup Guide Unit Assembly

Fig 1 Fig. 2

Fig. 3

Tripod / Positioner Assembly

WARNING: USE EXTREME CAUTION TO AVIOD DAMAGING ANY OF THE SMA CONNECTORS DURING ASSEMBLY

BEFORE YOU BEGIN: Unpack  ALL items and ensure there is no damaged or missing parts.

Assembly Steps-

1. Lay the positioner on its side and attach the Tripod Adapter Plate to the bottom of the Positioner using the 4
included Hex Cap Screws and included hex wrenches, use the blue marks for proper orientation (Fig. 1)

2. Unfold the Tripod and Loosen the height lock, Crank the hight up to 2 inches- (Fig. 2)

3. Place the positioner on the tripod by holding it upright and sliding the shaft on the adapter plate into the hole in
the top of the tripod neck, Rotate the assembly until you can fit the Included red-handled hex wrench into the set
screw located inside of the hole, tighten the set screw until tight. The positioner should now be securly mounted to
the tripod.  (Fig. 3)

4. The positioner should now be securly attached to the tripod and ready to attach cables.
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Addendum- Model 6000-100 Setup Guide Unit Assembly

Cable Connections

1. Attach the control/power harness to the side of the positioner (Fig. 1)

2. Connect the USB cable and the white cable from the control/power harness to the USB Interface box, DO NOT
connect to computer at this time (Fig. 2)

3. Connect the Power supply to the control/power harness (Fig. 3)

4. Connect one end of the precision cable to the side of the positioner, tighten well but do not over-torque (Fig. 4)

5. Connect the other side of the precision cable to port 1 or 2 of  your Test Equipment. (not shown)

Fig. 1 Fig. 2

Fig. 3 Fig. 4
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Addendum- Model 6000-100 Setup Guide Software  Setup

Installing the USB Driver

NOTE: If you were shipped a Pre-Configured Laptop or PC , you do NOT need to perform any of these steps, you
will only need to follow these instructions if you are re-installing the system.

NOTE: The DAMS software should be installed on the PC prior to performing the steps below.

1. Connect the DAMS Platform Controller to the Computer using the included USB Cable. A window should appear indicating
that a new device has been found. Do not select the option to automatically search for the latest driver!.

2. Click the Box labelled Search Manually then click  “Next”

3. Select CD-ROM

4, Click Next, You will then be prompted that the driver has not passed the WHQL certification. Select the “Continue Any-
way” button.

5. Click Finish.

6. A new window will pop up indicating another device has been found, repeat steps 2-5 above.

7. Open up the control panel on the computer (start->settings->control panel), double click on the system icon. (if using the
category view you must click “performance and maintenance” before you can open system) click the hardware tab then
click on “Device Manager”

8. Click the “+” sign next to “Ports COM&LPT” , the controller will listed as “USB Serial Port” Make note of the port
number on a piece of paper.

Configuring the DAMS software for the 6000-100 positioner

1. Start the DAMS software

2. Click the “Positioner Settings” button

3. Select the 6000-100 from the “Interface” pulldown

4. Select the proper COM port from the “port” pulldown

5. Press the “SAVE” button then press the “QUIT” button to quit the program and save settings.



66

Addendum- Model 6000-100 Setup Guide Unit Verification

Verifying Positioner connectivity and operation

The steps below will assit you with checking the 6000-100 positioner operation with the DAMS software.  All of the
previous steps for installing and configuring the software and connecting the cables should be completed before performing
the steps below.

Step 1. Ensure all cables are connected to the positioner and the Power Supply is plugged into a live AC outlet.

Step 2. Start the DAMS Antenna Measurement Software

Step 3. Vertical Movment Test
Set the Elevation slider to 90 Degrees and press the “MANUAL
MOVE” button, the positioner should tilt over at in 5 degree
increments until it reaches 90 degrees.  Now change the slider
to -90 degrees and press the “MANUAL MOVE” button, the
positioner should now move to -90 degrees in 5 degree
increments. If the positioner moved accordingly the elevation/tilt
portion of the system is functioning.

Step 4. Horizontal Movement Test
The Horizontal sliders should be pre-set to a value of 360
degrees total roation with 10 degrees per measurement with 37
total measurements.  Press the “MANUAL MOVE” button
under the settings to make the positioner simlate making the
37 measurements, the positioner should make a total pan of
360 degrees and stop. If the positioner moved accordingly the
Horizontal/Pan portion of the system is working properly.

Step 5. Resetting to 0, 0 Degrees
After you have completed the horizontal and vertical test you
need to press the “Reset ALL init. pos” button this will clear out
all position settings and move the positioner to 0 Deg. Az. and
0 Deg El.

The testing and verification of the Model 6000-1000 positioner has now been completed please see the next
section on using and making measurements with the 6000-100 positioner.
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Addendum- Model 6000-100 Setup Guide Using the 6000-100

Using the 6000-100 Positioner

NOTE: Refer to the Main Users’ Manual for detailed instructions on making antenna measurements, this section is
degined to advise you of specific items related to the 6000-100 postioner ONLY.

Using the 6000-100 positioner follows the same procedure as the original 5000,6000, or 7000 positioners except for
a few key items.

- The units positioner is tracked using internal absolute encoders, at zero degrees the posiioner will always
be in the same position

- The jog features in the software currently are disabled for the 6000-100 positioner.

Before making any measurements , ensure the postioner is at 0 Deg. Az. and 0 Deg. El , this can be accomplished
using the “RESET ALL INT. POS”  button in the software. you can now attach your antenna to the positioner ensuring it is
oriented properly to the fixed reference antenna, Use the pictures below to understand the orientation of the positioner for a
given position setting.  When making a scan measurement (horizontal and vertical) the postioner will move from 0-360
degrees for the first cut, then the positioner will tilt and scan back from 360 degrees to 0 degrees. it will continue with this
pattern of movements until the measurement is complete.

Positioning Examples

See the images below for an example of how the positioner will move when instructed to move

-90 degrees elevation  0 degrees elevation +90 degrees elevation

+90 degrees elevation
0/360 degrees azimuth

+90 degrees elevation
  90 degrees azimuth

+90 degrees elevation
 180 degrees azimuth

Elevation/Tilt Examples

Azimuth/Pan Examples
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Addendum- Model 6000-100 Setup Guide Specifications
Positioner Specs

Movement
Resolution: .1 degrees (both axis)
Horizontal/Az: 0-360 degrees
Vertical/El: -90 to +90 degrees
Horizontal/Az torque: 50 Ft lbs.
Vertical/El Torque: 150 Ft lbs.
Drivetrain: Precision worm drive with roller bearings
Weight Handling Capacity: 100 Lbs

Electrical

Volts: 24 VDC
Amps: 2.3
Interface: RS232 and USB converter

RF Connectivity

Frequency: DC-18 GHz
Rotary DUT connector: SMA Female
Stationary Connector: SMA Female
Rotary Joint: S.I.C based coaxial rotary joint

Physical Specs

Material: Powdercoated Aluminum
Weight : 44 Lbs (20 kg)
Height: 12.51” (31.8 cm)
Width:  12.61” (32 cm)
Depth:  8.87” (22.5 cm)

Tripod Specs

Material:  Aluminum and ABS
Weight:23 Lbs. (10.4 kg)
Height Min: 33.5” (85 cm)
Height Max:70” (178 cm)
Maximum Spread: 73” (185 cm)
Collapsed Dimensions (transport Mode) : 40.5” x 12.5” (102 x 31.3cm)
Leg Sections: 2
Column Travel: 18” (45 cm)
Foot Plate Diameter: 4” (10 cm) Self Leveling  5/8” hole for spiking
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Addendum- Model 6000-100 Setup Guide Troubleshooting

Positioner Troubleshooting

The DAMS 6000-100 Positioner is a very robust and stable positioner. In the event that you belive you may have a
problem with your positoiner. Please check the items below. If you do not see your problem listed below or you are not able
to get your problem resolved, please contact us and we will be happy to assist you with your problems.

Control/Power Connector Pinout.

The diagram below lists the connection points for Serial Control as well as DC power.

A: Serial Ground
B: 24 VDC +
C: Power Supply Ground -
D: Housing Ground
E: Serial TX
F: Serial RX

Problem: Software message is displayed that the positoner has reached its limit.
Possible Cause: The Horizontal/Vertical tracking in the software is out of sync.
Solution: Restart the software and press the “Reset All Init. Pos.” button to reset everything.

Problem: When Instructed to move the positioner does nothing
Possible Causes: Power is not connected, Wrong Port Selection, Software Glitch
Solution: Check all cables, Reboot PC , disconnect and reconnect positioner power.

If you think there may be a problem with the positioner itself, you may check the Control/Power port on the side of the
positioner using an ANALOG multimeter set to “ohms” and look for the following values- Refer to the connector
diagram below for proper pins. --NOTE POLARITY OF TEST LEADS-- All values within 10%

A- to F+: 8.1k
A- to E+: 13.3k
B- to Connector +: 21k (15 sec. settling time)
C to Connector : Short
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Warranty Information

The Antenna Measurement System is guaranteed for 2 years on parts and labor from the time it was received by you. If
there is a problem with the product please send us a picture or write a very detailed description of the problem, If we
determine that you have a faulty unit or bad part we will ship you a replacement part or unit with a self addressed box to
send the defective unit back with

Replacement Parts

If you ever need a replacement part for your rotator unit, Please call us or e-mail us for faster response and pricing
information. Most Repairs are covered under warranty except for damages resulting from obvious abuse or misuse of the
product

Contact Information

Visit us on the Web at Http://www.DiamondEng.net

Main Headquarters

Diamond Engineering
P.O. Box 2037
Diamond Springs, CA 95619
Phone- (530)626-3857
Fax- (530)626-0495

Administrative and financial questions
Name- Mike Hillbun
Email- mikehill@diamondeng.net

Technical Support and Warranty
Name- James Martin
Email- James@diamondeng.net


